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Introduction 
IVGraph is an interactive graphical service designed to help equity and option traders to analyze 

market and seek for different trading opportunities. 
Now one can plot any kind of data provided by unique IVolatility historical database, which 

includes implied and historical volatilities, prices, volumes and a lot more. Fully customizable 
interface allows users to create their own workspace with favorite equities and options, plot different 
parameters either on the same chart or have separate windows, arrange charts the way they like, apply 
technical analysis and take advantage of many other features. 

Easy to use, IVGraph provides boundless opportunities for analyzing historical volatilities, doing 
custom research of the market, thus finding the right time and candidates for trading. 

 
Current version covers stocks, indices, futures and options from US markets. 
 
Minimal System requirements: Java 1.5 or higher. 
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Getting started 
To launch the IV Graph, load the application and enter your User Name and Password (the same 

as you use at ivolatility.com) into the dialog window. 
 

 

User interface 

Main menu 
The main menu is located at the top of the program application window, right under the title bar. 

It contains all available commands and functions. 

 

File 

 
 
New window: Create a new window. 
Close window: Close the current window. 
New project: Create a new project. 
Open project: Open an existent project. 
Save project: Save the current project. 
Save project as: Save the current project with another name. 
Print: Print the current window. 
Exit: Exit the application. 
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Edit 

 
 
Zoom in/ Zoom out: Zoom in and out the current window. 
Show grid: Show or hide grid in the current window. 
Draw Candles/ Draw Bars / Draw lines: Draw all price charts in the current window with candles, 
bars or lines. 
New viewport: Create a new viewport in the current window. 
Rename window: Rename the current window. 
Delete chart: Display a window where you can select the chart to delete. 

Chart 

 
 
Add chart: Add a chart (see Creating charts). 
Add indicator: Add an indicator (see Technical Indicators). 
Properties: Display properties of the current window. 

Tools 

 
 
Cursor: View the chart in the cursor mode (see Reading the Data). 
Crosshair: View the chart in the cross mode. 
Trendline: Add a trend line (see Trend Lines). 
Parallel Trendline: Add a parallel trend line. 
Fibonacci: Add Fibonacci Levels (see Fibonacci Levels Trend Lines). 
Fibonacci Arcs: Add Fibonacci Arcs. 
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Help 

 
 
Statistics: The statistics of loaded securities for current user. 
About: Show the information about the current version of IV Graph. 

Control panels 

Standard panel 

 
Standard panel is located under the main menu. It contains the most important and recently used 
commands and functions. 
 

 Open an existent project. 

 Save the current project. 

 Create a new viewport in the current window. 

 Display properties of the current window. 

 Print the current window. 

 Zoom in and out the current window. 

 Draw all price charts in the current window with candles, bars or lines. 

Security panel 

 
 

Security panel is located under the Standard panel. 
 
To create a new stock or index chart, select Equities lookup mode. Then specify the security 

using  button and press Draw Chart button. 
 
To create a futures chart select Futures lookup mode and specify the security. Type a slash (‘/’) 

after the name of the underlying (e.g. ED/, for Eurodollar) to see the list of its futures. Finally, press 
Draw Chart button. 

NB: If you wish to draw the front contract price of the particular futures contract, you do not 
need to type a slash after the name of its underlying. 

Press Option Chain to build an option dataset (e.g. option price). See all the details in Creating 
charts chapter. 
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To change the time period of a plotted chart use  button.  

Wor

 select New Project.  To save the current 
t with another name use File – Save Project 

names are represented under the standard 
panel. You can switch between different windows by pressing their names. To create a new window in 
the cu t window use File ose Window or 
just p

king with projects 
A project is an .ivgp file which keeps all the information about charts. Each project can contain 

windows, viewports and charts. 
To create a new project, go to the File menu, then

project use File – Save Project. To save the current projec
As.  

To open an existent project use File – Open Project.  

Working with window and viewports 
Each project contains a number of windows, which 

rrent project use File – New Window. To close the curren – Cl
ress the cross button next to the name of the window. 

 
To rename the current window double-click on its name. 

 few viewports. To create a new viewport press  button on 
iewport right-click on it and select Close Viewport from a drop-

Wor

Crea

more detailed IVolatility Guide at 
http:/

Each window consists of a
the Standard Panel. To close the v
down menu. 

king with charts 

ting charts 
You can easily plot any kind of data including equity prices, implied and historical volatilities, 

IV Index, and a lot more. 
ou can check Y

/www.ivolatility.com/doc/IVolatility_Data_detailed.pdf to learn how our data suppo
rading analysis. Here we will provide a short description of the data to help 

rt investing 
and t quickly get 
acquainted how to use different datasets. 

e curren  following historical projections 

ataset 

 
In th t version, the are available for equities: 

 

D Projection Description 
Price Open Price Open prices chart for a specified period of dates 
 Close Price Close prices chart for a specified period of dates 
 High Price High prices chart for a specified period of dates 
 Low Price ow prices chart for a specified period of dates  L
 Candle Price Japanese candlestick chart for a specified period of dates 
 Daily Return Line chart of daily returns 
   
Stock Volume  Stock Volume Daily stock volume chart 
 

e 
me per equity chart. Available for Total  

Option Volum
Daily total option volu
calls, puts or total 

 Total Option 
 Interest 

aily total option open interest per equity chart. Available 
Open

D
for calls, puts or total 

 o call options Put/Call ratio A ratio of the trading volume of put options t
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Volatility HV  

Close-to-Close 20, 150, 180 days
Close-to-close historical volatility for set of standard 
terms: 10, 20, 30, 60, 90, 1

 HV High-to-Low Time series of high-to-low, also known as Parkinson, 
historical volatility for a set of standard terms: 10, 20, 30, 
60, 90, 120, 150, 180 days

Historical Volatility reflects the past price movements of the underlying asset, while implied volatility is a m
market expectations regarding the asset's future volatility. Historical volatility is also referred to as the asset's actual 
or realized volatility.  

easure of 

dex 

ity 

ime frames. 

ge, deviations from it, and subsequently, trading opportunities.  
ption premiums rise et participan  of a 
ock or index is high ndency for a 

stock or index that has high historical volatili ll 
reflect those expectations.  

Each equity has a unique level of volatility that changes over time. When historical volatility is high, it says that the 
stock has been showing extreme fluctuations in price. When it is low, it suggests quiet or sideways trading. 
Comparing it to the historical volatility of other stocks and indexes allows one to estimate whether the stock or in
is relatively volatile.  
Although volatility always changes, most indexes and stocks can be assigned an average value, since their volatil
tends to fluctuate around some normal or average value over long periods of time. To determine what volatility level 
is normal for a particular stock or index, traders must consider historical volatility across different t
Furthermore, viewing the historical volatility of a stock or index over time can help to determine whether the 
volatility is rising or falling. For example, if the 10-day historical volatility of a stock is 15% and the 120-day is 
45%, the stock has recently witnessed a sharp decline in volatility. Studying changes in the volatility of an asset can 
help identify a normal volatility ran
O
st

 when mark
, there is a te

ts expect greater stock volatility. When the historical volatility
the market to drive option premiums higher as well. One can expect 
ty to exhibit high volatility in the future, and the option premiums wi

 IV Index Time series of Implied Volatility Index for a set of 
standard terms: 20, 30, 60, 90, 120, 150, 180, 270, 360. 
Available for calls, puts or total 

IVX is VIX-like measure: an expected stock volatility over a future period. But unlike VIX, we provide an IVX num
not just for key stock indices but for each optionable name in US, Europe and Canada.The IVX is calculated by usi
a proprietary weighting technique f

ber 
ng 

actoring the Delta and Vega of each option participating in IVX calculations. In 

0, 90, 120, 150, 180, 360, 720 days) using a linear interpolation by the 
time. e
fferen

IVX is a great tool for volatility studies lookin
volatility and mean reversal principles. 

total, we use 4 ATM options within each expiration to calculate the Implied Volatility Index of each stock. This IV 
Index is normalized to fixed tenors (30, 6
squared root of 
name and for di

 The fundamental natur
t maturities.  

 of IVX is the same as VIX but we calculate IVX fir every optionable 

g for a single volatility value as well as studies reviewing historic stock 

IV Surface  IV by OTM/DTE e series of implied volatility defined by specified % 

4 

Tim
out-of-the-money strike (from -50% to +50% from spot 
with 10% step) and fixed term to expiration (from 1m to 2
m) 

 IV Skew by  
Moneyness 

Skew
difference between symmetric points around ATM po
for the fixed terms to expiration 

 time series chart, where skew is calculated as the 
int 

A surface normalized by moneyness and maturity. 
T
M

erms: 1, 2, 3, 4, 5, 6
oneyness: (-50%, - ,

Surface by moneyness allows historical analy
with the same moneyness and days remaining tion, that was observed in the past. 

, 12, 24 months 
40%, -30%, -20%, -10%  0% (OTM puts), 0%, 10%, 20%, 30%, 40%, 50% (OTM calls) 

sis of implied volatility, i.e. to compare the current option price (IV) 
 to expira

 IV by Delta/DTE Time series of implied volatility  of option with specific 
delta (from 0.1 to 0.9) and term to expiration (from 1m to 
24 m). 

 IV Skew by Delta Skew time series chart, where skew is calculated as the 
difference between symmetric points around 0.5 delta point 
for the fixed terms to expiration 

Volatility Surface by Delta: 
A surface normalized by delta and maturity 
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Term  1,2,3,4,5,6, 9, 12,24 months 
Delta
Surfa  volatility skew with a 

. 

s:
s: (from 0.1 to 0.9 with step 0.05) 
ce by Delta is the most accurate way to analyze historical behavior of particular option or

given delta
 

Additionally, the following histor le for futures: 

ataset 

ical projections are availab

D Projection Description 
Price uture Price uture midmarket prices chart for a specified period of F F

dates 
 Daily Return Line chart of daily returns 
   
Stock Volume e Future Volum Daily future volume chart 
 Total  

Option Volume 
Daily total future option volume chart. Available for calls, 
puts or total 

 T
O

otal Option 
pen Interest 

re option open interest chart. Available for 
alls, puts or total 

Daily total futu
c

 Put/Call ratio A ratio of the trading volume of put future options to call 
future options 

   
Volatility HV  

Close-to-Close 
for set of 

tandard terms 
Time series of close-to-close historical volatility 
s

 IV Index Time series of Implied Volatility Index for a set of 
standard terms. Available for calls, puts or total 

   
IV Surface  DTE 

expiration 
IV by OTM/ Time series of implied volatility surface point fixed by 

specified moneyness and term to 
 IV Skew by  Skew time series chart, where skew is calculated as the 

 around ATM point 
erms to expiration 

Moneyness difference between symmetric points
for the fixed t

 

The following historical datasets ions are available for options: project

Dataset Projection Description 
Option Price f 

dates 
Option Price Option midmarket prices chart for a specified period o

   
Option 
Volume 

Individual Option 
Volume 

Daily volume chart for an individual option contract. 

 Individual Option 
Open Interest 

Daily open interest chart for an individual option contract 

   
Raw IV Raw IV Implied volatility time series chart for an individual option 

contract 

To build a chart, select Chart menu, then select Add Chart submenu. In this submenu select the 
dataset and projection. 
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Then enter the security and the viewport where you want to place the chart and specify the 

parameters. Alternatively, you can create a chart using Draw Chart button from the security panel. 
 
To build an option dataset specify option symbol. To do that, at first select the stock in the list of 

the loaded instruments. Click the Lookup button to enter the Option Lookup Dialog. 

 
 
Here a desired option symbol can be selected by specifying option parameters: Type (call, put), 

Strike (the list of strikes in the combo-box depends on the stock symbol loaded) and Expiration (the 
list of expirations in the combo-box depends on the stock symbol loaded). The option symbol can be 
added to the list of instruments by selecting the corresponding symbol in the list of matches and 
pressing OK thereafter. 

After it press Draw Chart button from the security panel and specify the parameters of the chart. 

Scales 
In the current version, you can plot time-series charts. The horizontal scale is always the time 

scale. The vertical one is the value scale with the corresponding units. If there is only one chart at the 
viewport or all the charts at the viewport belong to the same dataset then the viewport has a single 
vertical scale. Otherwise the vertical scale becomes multiple and you can switch between scales by 
clicking the right button on a scale. 
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You can always switch between general vertical scale mode and separate scales mode by presing 
the right button on the viewport and selecting General Vertical Scale from the drop-down menu. 

 
For zooming in and out, press the corresponding button  on the window’s control panel, 

or choose the corresponding command from the drop-down menu. 

Reading the Data 
Numerical data are available for viewing from the cursor. Simply hover the cursor to the plot 

and a context window displaying the value of the series at the corresponding time will pop-up. 
To switch the cursor to the cross mode for a more convenient view go to the Tools menu, then 

select Crosshair. Use Tools-Cursor to return back to cursor mode. 
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Customizing charts 

Working with Candle chart 
Candle chart visualizes open, high, low and close values for each date. Using buttons on the 

window’s control panel you can switch the type of Candle plot renderer between usual Japanese 

candlesticks, bars or just linear plot drew using close values: . 

Changing background and plots appearance 
All appearance settings are in the Properties window. To open it go to the Chart menu, then 

select Properties or click the  button on the window’s control panel.  
This window consists of two sections. On the left you can see opened viewports’ structure and 

the list of plotted charts and indicators for each viewport. Selecting window, viewport, chart or 
indicator you will see its appearance properties on the right and will be able to change it. 

You can also decide whether to show or not to show grid for each window, and choose 
background, foreground and grid colors. 

 
 
The following plot properties are editable: 
• Draw color 
• Fill color (for candlestick charts only) 
• Line style 
• Line width 

 

Moving charts 
Users can change the location (the parental inner window) of any time series plot. Moving a plot 

implies deleting the plot from its original location and inserting it to some other. 
• Left-click on a plot 
• Drag the mouse arrow to another inner window while holding the left mouse button 
• Release the mouse button 
The plot will be placed into the new location with the best scaling options applied. 
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Printing charts 
To print a viewport or the whole window, go to File menu then choose Print. In the opened 

window select the viewport you would like to print and press OK. Select All if you would like to print 
the current window. 

 

Deleting charts 
To delete a plot, right-click on it and select Delete from the drop-down menu. 
 

 
 
Alternatively, you can go to the Edit menu and then choose Delete Chart. In the opened window 

select the plot you would like to delete and press Delete button at the bottom of the window.  
 

 

Analytics 
A number of instruments such as technical indicators, trend lines and Fibonacci levels are 

provided for analytical purposes. These instruments are applied directly to charts and provide a 
possibility to forecast future price dynamics. 
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Trend Lines 
You can add trend lines to the viewport area. Go to the Tools menu and then select Trendline. 

Fix the first point of the line and then the second point. In the similar way, you can add a parallel trend 
line. 

 

 
 
Being plotted the line could be moved by moving the red points on the line. To change the 

properties of a plotted trend line, go to the Properties window (Chart – Properties) and select the trend 
line at the left part of the window. 

NB: Trend lines could be applied only if the viewport has separate scales (rather than general 
one). If the current viewport has a general scale, just switch to a separate scale to build a trend line. 

Fibonacci Levels 
You can add Fibonacci levels to the viewport area. Go to the Tools menu and then choose 

Fibonacci. After that fix 0% vertical level point and then 100% level point: 
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Being plotted the levels graph could be moved by moving the red points on the line. In the 

similar way, you can add Fibonacci arcs. To change the properties of the plotted Fibonacci levels, go 
to the Properties window (Chart – Properties) and select the Fibonacci levels at the left part of the 
window. 

NB: Fibonacci levels could be applied only if the viewport is in separate scales mode (rather 
than in general mode). If the current viewport has a general scale, just switch to a separate scale mode 
to build a Fibonacci level. 

Technical Indicators 
To add a technical indicator, go to the Chart menu and select Add Indicator submenu. Then 

select an indicator from the drop-down menu. In the following dialog, specify the argument, the 
indicator parameters and viewports where the indicator will be plotted. 

 
 
The list of available indicators 

• SMA. Simple moving average. 
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Parameters. Period is a number of days in the time frame.  

• SMMA. Smoothed moving average. 
Parameters. Period is a number of days in the smoothing period. 

• EMA. Exponential moving average. 
Parameters. Period is a number of days in the time frame. 

• LWMA. Linear weighted moving average. 
Parameters. Period is a number of days in the smoothing period. 

• CCI. Commodity Channel Index. The CCI is designed to detect the beginning and the ending 
market trends. CCI represents the position of the current price relative to the average of price over a 
recent period. 

Parameters. Period is a number of days for calculating a moving average and standard deviation. 

• ROC. Rate of Change Indicator. It is very similar to the Momentum indicator, but for the 
calculations of this indicator the price difference is taken, so it is less by 100. 

Parameters. Period is a number of days you look in the past. 

• RSI. The Relative Strength Index. The RSI oscillates in a range between 0 and 100 representing the 
magnitude of the stock's recent gains in comparison to the magnitude of its recent losses. 

Parameters. Period is a number of days in the time frame. 

• Momentum. The Momentum Technical Indicator. Measures the amount of a security’s price 
change over a given time period. 

Parameters. Period is a number of days you look in the past. 

• BB. Bollinger Bands. Same period is used for calculating a moving average and standard deviation. 
Parameters. Period is a number of days for calculating a moving average and standard deviation. 

STD# - number of standard deviations for bands building. 

• Alligator. Alligator Technical Indicator is a combination of balance lines. The blue line (Alligator’s 
Jaw) is the balance line for the timeframe that was used to build the chart. The red line (Alligator’s 
Teeth) is the balance line for the value timeframe of one level lower. The green line (Alligator’s 
Lips) is the balance line for the value timeframe, one more level lower. Gator Oscillator is usually 
drawn in a separate window; it shows the degree of convergence/divergence of the balance lines. 
The top bar chart is the absolute difference between the values of the blue and the red lines. The 
bottom bar chart is the absolute difference between the values of the red line and the green line, but 
with the minus sign, as the bar chart is drawn top-down. 

Parameters. Alligator’s Jaw, Teeth and Lips are periods and shifts for building the three balance lines. 

• ADX. The average directional movement index. It is plotted together with positive and negative 
directional indicator lines. Same period is being used for calculating directional indicators and the 
average directional movement index. 

Parameters. Period is a number of days for calculating moving averages. 

• MACD. Moving Average Convergence/Divergence is the next trend-following dynamic indicator. 
It indicates the correlation between two price moving averages. We offer to plot five charts related 
to MACD – two exponential moving averages for different terms, difference between them i.e. 
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MACD directly, simple moving average of MACD i.e. MACD signal and histogram of difference 
between MACD and its signal. 

Parameters. First and second EMA periods are the number of days for each of EMA calculations, 
SMA period is a number of days for SMA calculation. 

Changing indicator parameters 
You can change the parameters of the indicator once it was plotted. Go to the Chart menu, then 

choose Properties or click the  button on the window’s control panel. In the Properties window 
select the indicator at the left part, and change its parameters at the right part of the window. 

 

User statistics 
This window allows you to see the list of loaded securities during the current month. Once you 

press the name of the column, the table will immediately be sorted by this column. 
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